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Edraw Office Viewer Component 

Edraw Office Viewer Component is the contains a standard ActiveX control 

that acts as an ActiveX document container for hosting MS Word, MS Excel 

and MS PowerPoint in a custom form or Web page. The control is lightweight 

and flexible, and gives developers new possibilities for using Office program 

in a custom solution. 

The control is designed to handle specific issues that make using ActiveX 

documents from a non-top-level host window difficult, and serves as a 

starting place for constructing your own embedded object file viewer or 

editor as an ActiveX control. 

How to add “Edraw Office Viewer Component” to your Visual 

Basic 6.0 project  

1. From the Project Menu select Components… 

2. Select control “Edraw Office Viewer ActiveX Control Module” in the 
controls table 

3. Click the OK Button 

4. The control will now appear in your toolbox 

5. Drag and drop the control on your form 

How to add “Edraw Office Viewer Component” to your .NET 

project 

1. Open .NET 

2.  Right-click on the toolbox and select "Choose Items…" 

3. Select the COM Components Tab 



4. Check “Edraw Office Viewer Component” and click OK Button 

5. The control should appear in the toolbox as "Edraw Office Viewer 
Component" 

6. Double-click on the control to add to your form 

7. Resize and move the control on the form as desired 

8. Add a button to the form 

9. Double-click on the button to access code editor and enter the 
following code within the Click event: Note: Modify code to point to an 
existing document file on your web server 

10. EDOffice.Open " 
http://www.edrawsoft.com/demo/samples/sample.xls" 

11. Run the application and click on the button 

For ASP.NET or PHP project, you needn't add the component to the toolbar. 
View the “read me.txt” file in the “install folder\samples\ASP.NET\” folder 



 

Methods 
 

boolean IsOfficeInstalled(BSTR ProgID); 

Returns whether the client installs the Special MS Office program. 
ProgID: Word.Application, Excel.Application, PowerPoint.Application. 

 

BSTR GetCurrentProgID(); 

Returns the program id of the current opened document. 

Return: The value should be Word.Application,  Excel.Application or PowerPoint.Application. 

 

IDispatch* ActiveDocument(); 

Returns the Automation interface of the document object.  

The method allows you to obtain a reference to the IDispatch interface 
of the embedded object. From this interface you can automate the 
object to perform tasks, edit parts of the document, or gather 
information about what a user has added or removed.  

For example, you can create a new worksheet then write the cells: 

<script language="javascript"> 
function OfficeAutomation() 
{ 
EDOffice.CreateNew(“Excel.Application”); 
var objExcel = EDOffice.GetApplication();  
var worksheet = objExcel.ActiveSheet; 
worksheet.cells(1,1).value ="100"; 
worksheet.cells(1,2).value ="101"; 
worksheet.cells(1,3).value ="102"; 
worksheet.cells(2,1).value ="103"; 
worksheet.cells(2,2).value ="104"; 
worksheet.cells(2,3).value ="105"; 
} 
</script> 



 

IDispatch* GetApplication(); 

Returns the Automation interface of the application. 

 

boolean CreateNew(BSTR ProgID); 

Creates a new, empty document. 
ProgID: Word.Application, Excel.Application, PowerPoint.Application. 

 
Example 
The following vb script shows how to open word.  
Sub NewDoc_Example()     
EDOffice.CreateNew “Word.Application” 
End Sub 

 

boolean Open(BSTR FileName, [in, optional] VARIANT 
ProgID); 

Opens the specified document. 
FileName: The name of the document (needs the full paths or url). 
ProgID: Word.Application, Excel.Application, PowerPoint.Application. 

 
 
Example 
The following vb script shows how to open word file.  
Sub LoadFile_Example()     
EDOffice.Open  “c:\test.xlsx”, “Excel.Application” 
End Sub 
 
 
Sub LoadURL_Example()     
EDOffice.Open  “http://www.ocxt.com/demo/samples/sample.xls”, “Excel.Application” 
End Sub 

 

boolean Save(); 

Saves the specified document. If the document hasn't been saved 

before, the Save As dialog box prompts the user for a file name. 



 

boolean SaveAs([in] BSTR FilePath, [in, optional] VARIANT 
FileFormat); 

Saves the document to specified location with the specified format. 
FilePath: The name for the document. If a document with the specified file name already 
exists, the document is overwritten without the user being prompted first. 
FileFormat: The format in which the document is saved. Can be any WdSaveFormat constant. 
 
enum WdSaveFormat 
{ 
wdFormatDocument = 0, 
wdFormatTemplate = 1, 
wdFormatText = 2, 
wdFormatTextLineBreaks = 3, 
wdFormatDOSText = 4, 
wdFormatDOSTextLineBreaks = 5, 
wdFormatRTF = 6, 
wdFormatUnicodeText = 7, 
wdFormatEncodedText = 7, 
wdFormatHTML = 8, 
wdFormatWebArchive = 9, 
wdFormatFilteredHTML = 10, 
wdFormatXML = 11 
}WdSaveFormat; 
 
enum XlFileFormat 
{ 
xlAddIn = 18, 
xlCSV = 6, 
xlCSVMac = 22, 
xlCSVMSDOS = 24, 
xlCSVWindows = 23, 
xlDBF2 = 7, 
xlDBF3 = 8, 
xlDBF4 = 11, 
xlDIF = 9, 
xlExcel2 = 16, 
xlExcel2FarEast = 27, 
xlExcel3 = 29, 
xlExcel4 = 33, 
xlExcel5 = 39, 
xlExcel7 = 39, 
xlExcel9795 = 43, 
xlExcel4Workbook = 35, 
xlIntlAddIn = 26, 
xlIntlMacro = 25, 
xlWorkbookNormal = -4143, 
xlSYLK = 2, 
xlTemplate = 17, 
xlCurrentPlatformText = -4158, 
xlTextMac = 19, 
xlTextMSDOS = 21, 
xlTextPrinter = 36, 



xlTextWindows = 20, 
xlWJ2WD1 = 14, 
xlWK1 = 5, 
xlWK1ALL = 31, 
xlWK1FMT = 30, 
xlWK3 = 15, 
xlWK4 = 38, 
xlWK3FM3 = 32, 
xlWKS = 4, 
xlWorks2FarEast = 28, 
xlWQ1 = 34, 
xlWJ3 = 40, 
xlWJ3FJ3 = 41, 
xlUnicodeText = 42, 
xlHtml = 44 
}XlFileFormat; 
 
enum PpSaveAsFileType 
{ 
ppSaveAsPresentation = 1, 
ppSaveAsPowerPoint7 = 2, 
ppSaveAsPowerPoint4 = 3, 
ppSaveAsPowerPoint3 = 4, 
ppSaveAsTemplate = 5, 
ppSaveAsRTF = 6, 
ppSaveAsShow = 7, 
ppSaveAsAddIn = 8, 
ppSaveAsPowerPoint4FarEast = 10, 
ppSaveAsDefault = 11, 
ppSaveAsHTML = 12, 
ppSaveAsHTMLv3 = 13, 
ppSaveAsHTMLDual = 14, 
ppSaveAsMetaFile = 15, 
ppSaveAsGIF = 16, 
ppSaveAsJPG = 17, 
ppSaveAsPNG = 18, 
ppSaveAsBMP = 19, 
ppSaveAsOpenXMLPresentation = 24, 
ppSaveAsOpenXMLPresentationMacroEnabled = 25, 
ppSaveAsOpenXMLShow = 28, 
ppSaveAsOpenXMLShowMacroEnabled = 29, 
ppSaveAsOpenXMLTemplate = 26, 
ppSaveAsOpenXMLTemplateMacroEnabled = 27,  
}PpSaveAsFileType; 
 
Example 
The following vb script shows how to save as a word document.  
Sub SaveAs_Example()     
EDOffice.SaveAs  “c:\test.xls” 
End Sub 
 

boolean CloseDoc([in, optional] VARIANT SaveChanges); 

Closes the specified document or documents. 
SaveChanges: Specifies the save action for the document.  



 

boolean IsDirty(); 

Returns True/False if file has been altered or needs save. 

  

boolean IsOpened(); 

Returns True/Fase if file has been opened.  

 

boolean OpenFileDialog([in, optional] VARIANT Filter); 

Calls the standard file dialog to open the office document. 
Filter: The file filter string. 
 
Example 
The following vb script shows how to open only the docx file dialog.  
Sub OpenFileDialog_Example()     
EDOffice.OpenFileDialog  "Microsoft Excel 
Files(*.xl;*.xlsx;*.xlsb;*.xlam;*.xltx;*.xltm;*.xls;*.xlt;*.xla;*.xlm;*.xlw)|*.xl;*.xlsx;*.xlsb;
*.xlam;*.xltx;*.xltm;*.xls;*.xlt;*.xla;*.xlm;*.xlw||” 
End Sub 
 

boolean SaveFileDialog([in, optional] VARIANT Filter); 

Calls the standard file dialog to save the office document. 
Filter: The file filter string. 
 

boolean PrintDialog(); 

Calls the print dialog. 

boolean PrintOut( WdPrintOutRange PrintRange, [in, optional] 
VARIANT FromPage, [in, optional] VARIANT ToPage, [in, 
optional] VARIANT Pages, [in, optional] VARIANT Copies); 

Prints all or part of the specified document with settings. 
PrintRange: Optional Object. The page range. Can be any WdPrintOutRange constant. 



FromPage: Optional Object. The starting page number when Range is set to wdPrintFromTo. 

ToPage:  Optional Object. The ending page number when Range is set to wdPrintFromTo. 
Pages: Optional Object. The page numbers and page ranges to be printed, separated by 
commas. For example, "2, 6-10" prints page 2 and pages 6 through 10. 
Copies: Optional Object. The number of copies to be printed. 
 
enum WdPrintOutRange 
{ 

wdPrintAllDocument = 0, 
wdPrintSelection = 1, 
wdPrintCurrentPage = 2, 
wdPrintFromTo = 3, 
wdPrintRangeOfPages = 4  

}; 
 
Example 
The following vb script shows how to print the 3-6 page in a document.  
Sub PrintOut_Example()     
EDOffice.PrintOut 3, 3, 6 
End Sub 
 

boolean PrintPreview(); 

Starts a print preview. 

   

boolean PrintPreviewExit(); 

Exits a current print preview. 

 

boolean SetValue([in] BSTR Name, [in] BSTR Value); 

Sets the pasword, writepassword, domain and protectmodereminder 

for the document. 
Name: The name string. 
Value: The value string. 
 
 
Example 
The following vb script shows how to open a password-protected document. if the 1.docx file 

has the password 1234, the writepassword 5678, you can use the follow sample. 
 
Sub SetValue_Example()     
EDOffice.SetValue  "Password”, “1234” 
EDOffice.SetValue  "WritePassword”, “5678” 



‘EDOffice.SetValue “Domain”, “www.edrawsoft.com” 
‘EDOffice.SetValue “ProtectModeReminder”, “The ActiveX Controls is not available for Internet 
sites under the enhanced security configuration.” 
EDOffice.Open “c:\1.xls” 
End Sub 
 

boolean ProtectDoc(long ProtectType, [in, optional] VARIANT 
Password); 

Helps to protect the specified document from changes. When a 

document is protected, users can make only limited changes, such as 

adding annotations, making revisions, or completing a form. 
ProtectType: The protection type for the specified document. WdProtectionType. 
Password: Optional Object. The password required to remove protection from the specified 
document. 
 
For Excel: 
 
typedef enum XlProtectType 
{ 
 XlProtectTypeNormal = 0x00000001, 
 XlProtectTypeWindow = 0x00000002, 
 XlProtectTypeStruct = 0x00000004, 
 XlProtectTypeDrawingObjects = 0x00000010, 
 XlProtectTypeContents = 0x00000020, 
 XlProtectTypeScenarios = 0x00000040, 
 XlProtectTypeUserInterfaceOnly = 0x00000080, 
}XlProtectType; 
 
Example 
The following vb script shows how to protect a document for only revisions.  
Sub ProtectDoc_Example()     
EDOffice.ProtectDoc  XlProtectTypeNormal|XlProtectTypeWindow|XlProtectTypeStruct 
End Sub 
 

For Word: 
enum WdProtectType 
{ 
 wdAllowOnlyRevisions = 0, 
 wdAllowOnlyComments = 1, 
 wdAllowOnlyFormFields = 2, 
 wdAllowOnlyReading = 3,   
 wdNoProtection = -1, 
}WdProtectType; 
Example 
The following vb script shows how to protect a document for only revisions.  
Sub ProtectDoc_Example()     
EDOffice.ProtectDoc  0 
End Sub 



 

boolean UnProtectDoc([in, optional] VARIANT Password);
  

Removes protection from the specified document. If the document isn't 

protected, this method generates an error. 
Password: Optional Object. The password required to remove protection from the specified 
document. 
 
Example 
The following vb script shows how to unprotect a document with password 832-f2322.  
Sub Unprotect_Example()     
EDOffice.UnProtectDoc  “832-f2322” 
End Sub 
 

BSTR GetDocumentName(); 

Returns the name of the specified object. 

 

BSTR GetDocumentFullName(); 

Specifies the name of a document, template, or cascading style sheet, 

including the drive or Web path. 

 

boolean IsReadOnly(); 

Determines if changes to the document cannot be saved to the original 

document. 

boolean DisplayGridline([in] boolean Show); 

Shows/HIdes the grid lines in the office program. 

 

boolean SwitchViewType([in] XlViewType ViewType); 



Switches to the different view for office program. 
ViewType: The view type for the specified document. XlViewType. 
 
For Excel: 
typedef enum XlViewType 

{ 

 xlNormalView = 1 , 

 xlPageBreakPreview = 2, 

}XlViewType; 

 

Example 
The following vb script shows how to switch to webview after document opened.  
Sub DocumentOpenedEvent () 
EDOffice.SwitchViewType 1 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 

For Word: 
enum WdViewType 
{ 
 wdMasterView = 5,  
 wdNormalView = 1 , 
 wdOutlineView = 2, 
 wdPrintPreview = 4 , 
 wdPrintView = 3,  
 wdReadingView = 7,  
 wdWebView = 6, 
}WdViewType; 

 

Example 
The following vb script shows how to switch to webview after document opened.  
Sub DocumentOpenedEvent () 
EDOffice.SwitchViewType 6 
 

boolean ViewZoomTo([in] WdPageFit FitType, [in, optional] 
VARIANT ZoomFactor); 

Zooms to the special zoom factor.  
FitType: The zoom mode for the specified document. WdPageFit. 
ZoomFactor: The zoom factor. 
 
For Word:  
enum WdPageFit 
{ 



 wdPageFitTextNone = 0 , 
 wdPageFitFullPage = 1, 
 wdPageFitBestFit = 2,  
 wdPageFitTextFit = 3 ,  
}WdPageFit; 

 

The following vb script shows how to zoom the document to 200%.  
Sub DocumentOpenedEvent () 
EDOffice.ViewZoomTo -1, 200 
‘ fit best fit 
‘EDOffice.ViewZoomTo 2  
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 
For Excel and PowerPoint: 
 
The following vb script shows how to zoom the document to 200%.  
Sub DocumentOpenedEvent () 
EDOffice.ViewZoomTo  200 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 

boolean DisableViewRightClickMenu(boolean Disable); 

Disables the right click menu in the MS Word and Excel. 

 

boolean WordDisableSaveHotKey(boolean Disable); 

Disables the Save keycodes in the MS Word. 
Disalbe: Disables the CTRL+S, SHIFT+F12, Alt+SHIFT+F2, F12 

 

boolean WordDisablePrintHotKey(boolean Disable); 

Disables the Print keycodes in the MS Word. 
Disalbe: Disables the CTRL+P, CTRL+SHIFT+F12, CTRL+F2, ALT+CTRL+I 

 



boolean WordDisableCopyHotKey(boolean Disable);  

Disables the Copy keycodes in the MS Word. 
Disalbe: Disables the CTRL+C, CTRL+V, CTRL+X, SHIFT+DEL, SHIFT+INSERT, ALT+CTRL+V, 

CTRL+SHIFT+C, CTRL+INSERT 

boolean DisableFileCommand([in] WdUIType UIType, [in] 
boolean Disable); 

UIType: The enum type need to disable in the UI. WdUIType. 

Disable: True to disable the command button or menu item. 

 
enum WdUIType 
{ 
 wdUIDisalbeOfficeButton   =    0x00000001, 
 wdUIDisalbeNew =    0x00000002, 
 wdUIDisalbeOpen  =    0x00000004, 
 wdUIDisalbeUpgradeDocument     =    0x00000008, 
 wdUIDisalbeSave =    0x00000010, 
 wdUIDisalbeSaveAs=    0x00000020, 
 wdUIDisalbeSendAsAttachment   =    0x00000040, 
 wdUIDisalbeClose =    0x00000100, 
 wdUIDisalbePrint =    0x00000200, 
 wdUIDisalbePrintQuick   =    0x00000400, 
 wdUIDisalbePrintPreview   =    0x00000800, 
 wdUIDisalbeSaveAsMenu   =    0x00001000, 
 wdUIDisalbePrepareMenu   =    0x00002000, 
 wdUIDisalbePermissionRestrictMenu   =    0x00004000, 
 wdUIDisalbeSendMenu  =    0x00008000, 
 wdUIDisalbePublishMenu  =    0x00010000, 
 wdUIDisalbeServerTasksMenu   =    0x00020000, 
 wdUIDisalbeCopyButton   =    0x00040000, 
 wdUIDisalbeCutButton   =    0x00080000, 
 wdUIHideMenuHome   =    0x01000000, 
 wdUIHideMenuInsert   =    0x02000000, 
 wdUIHideMenuPageLayout   =    0x04000000, 
 wdUIHideMenuReferences   =    0x08000000, 
 wdUIHideMenuMailings   =    0x10000000, 
 wdUIHideMenuReview   =    0x20000000, 
 wdUIHideMenuView   =    0x40000000, 
 wdUIHideMenuDeveloper   =    0x80000000, 
 wdUIHideMenuAddIns   =    0x00100000, 
 wdUIHideMenuFormat   =    0x00200000, 
 wdUIHideMenuEdit   =    0x00400000, 
 wdUIHideMenuTool   =    0x00800000, 
}WdUIType; 
 
Note: The component disabled the Office menu, New button and Open 

button in default.  



DWORD dwDisableCommand = wdUIDisalbeOfficeButton | 

wdUIDisalbeNew| wdUIDisalbeOpen; 

The function need be set in the BeforeDocumentOpened event. 

 
If you want to enable the three button, follow the samples. 
 
Example 
The following vb script shows how to enable the office main menu, new button and open 
button. 
Sub DocumentOpenedEvent () 
EDOffice.DisableFileCommand 1 , false    ‘wdUIDisalbeOfficeButton    
EDOffice.DisableFileCommand 2 , false    ‘wdUIDisalbeNew 
EDOffice.DisableFileCommand 4 , false   ‘wdUIDisalbeOpen 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 
The following vb script shows how to diable the saveas and save button. 
Sub DocumentOpenedEvent () 
EDOffice.DisableFileCommand 16 , true    ‘wdUIDisalbeSave 
EDOffice.DisableFileCommand 32 , true    ‘wdUIDisalbeSaveAs 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 

boolean UpdateOffice2003ToolbarButton([in] long OfficeID, 
[in] boolean Visible, [in] boolean Enabled); 

Disables or hides the office 2000, 2003 toolbar button. 
OfficeID: The office MSO id for every button. 

Visible: True to set the command button visible. 

Enabled: True to enable the command button. 

The function works only in the Office 2000/2003 version. 

 
The following vb script shows how to hide the saveas and save button. 
Sub DocumentOpenedEvent () 
EDOffice.UpdateOffice2003ToolbarButton 3 , false, false    ‘save button 
EDOffice.UpdateOffice2003ToolbarButton 748 , false, false    ‘saveas button 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 



boolean InvisibleOffice2003Toolbar([in] BSTR ToolbarName); 

Disables or hides the office 2000, 2003 toolbar. 
ToolbarName: The office 2000, 2003 commandbar name. 

 
The following vb script shows how to hide the standard toolbar, web toolbar and formatting 
toolbar. 
Sub DocumentOpenedEvent () 
EDOffice.InvisibleOffice2003Toolbar “Standard” 
EDOffice.InvisibleOffice2003Toolbar “Web” 
EDOffice.InvisibleOffice2003Toolbar “Formatting” 
End Sub  
 
<SCRIPT FOR=OA1 EVENT= DocumentOpened ()> 
    DocumentOpenedEvent() 
</SCRIPT> 
 

boolean HttpInit(); 

Initializes the HTTP connection. 

 

boolean HttpAddPostString(BSTR Name, BSTR Value); 

Adds the post parameter. 
Name: The parameter name. 
Value: The parameter value. 
 

boolean HttpAddPostFile(BSTR LocalFilePath, [in, optional] 
VARIANT NewFileName); 

Adds the post file. 
LocalFilePath: The full file path needs to upload to the server. It the parameter is NULL, the 
function will add the file which is opening in the component. 
NewFileName: The new file name for the upload file. 
 

boolean HttpAddPostOpenedFile([in, optional] VARIANT 
NewFileName); 

Adds the opened office file to post queue. 



NewFileName: The new file name for the upload file. 

 

boolean HttpPost(BSTR WebUrl, [in, optional] VARIANT 
WebUsername, [in, optional] VARIANT WebPassword);  

Sends the specified request to the HTTP server. 
WebUrl: A string containing the web url from which uploads data via HTTP. 
WebUsername: A string containing the user name. 
WebPassword: A string containing the access password. 
 
The follow code is demo how to upload the opened file to server with the HTTP mode. It can 
also post multiple files in a post request. 
 
<script language="vbscript"> 
Sub UploadFile() 
EDOffice.HttpInit 
EDOffice.HttpAddpostString "author", "anyname" 
EDOffice.HttpAddpostString "Data", "2010-5-15" 
EDOffice.HttpAddPostOpenedFile 
EDOffice.HttpPost "http://localhost:1320/Samples/UploadAction.aspx"  
End Sub 
</script>  
 
Note: If you try to save the opened file to remote server with the “HTTP” methods, you need 
write a receipt page in your web server. Because the component uploads the file by HTTP 
mode. The follow is some sample code. 
 
ASP.NET:  
//Default.aspx 
<script language="vbscript"> 
Sub SavetoServer()  
EDOffice.HttpInit 
EDOffice.HttpAddpostString "author", "anyname" 
EDOffice.HttpAddpostString "Data", "2010-5-15" 
EDOffice.HttpAddPostOpenedFile 
EDOffice.HttpPost "http://localhost:1320/Samples/UploadAction.aspx"  
'EDOffice.Save "http://localhost:1320/UploadAction.aspx?author=name&Data=2” 
End Sub 
</script>  
 
//UploadAction.aspx.cs file 
using System; 
using System.Collections; 
using System.ComponentModel; 
using System.Data; 
using System.Drawing; 
using System.IO; 
using System.Web; 
using System.Web.SessionState; 
using System.Web.UI; 
using System.Web.UI.HtmlControls; 
using System.Xml; 
using System.Drawing.Imaging; 



using System.Text.RegularExpressions;  
 
public partial class UploadAction : System.Web.UI.Page 
{ 
    protected void Page_Load(object sender, EventArgs e) 
    { 
        if (Request. QueryString["author"] == "name" && Request. QueryString["Data"] == "2") 
        { 
            Response.Write("0\n"); 
            Response.Write("We have receipted the right param from Edraw Diagram ActiveX 
Control."); 
        } 
        if (Request.Files.Count == 0) 
        { 
            Response.Write("0\n"); 
            Response.Write("There isn't file to upload."); 
            Response.End(); 
        } 
        if (Request.Files[0].ContentLength == 0) 
        { 
            Response.Write("0\n"); 
            Response.Write("Failed to receipt the data.\n\n"); 
            Response.End(); 
        } 
        string fullFileName = Server.MapPath(Request.Files[0].FileName);  
        Request.Files[0].SaveAs(fullFileName); 
        Response.Write("Upload Successfully."); 
        Response.End(); 
    } 
}       
 
PHP:  
<?php 
header("http/1.1 200 OK"); 
$user = iconv("UTF-8", "UNICODE", $_POST['user']); 
$passwd = iconv("UTF-8", "UNICODE", $_POST['passwd']); 
$sql = sprintf("username=%s  passwd=%s", $user,$passwd); 
echo $sql; 
$sql = sprintf("file=%s  size=%s error=%s tmp=%s", 
$_FILES['trackdata']['name'],$_FILES['trackdata']['size'],$_FILES['trackdata']['error'],$_FILES
['trackdata']['tmp_name']); 
echo $sql; 
$handle = fopen($_FILES['trackdata']['name'],"w+"); 
if($handle == FALSE) 
{ 
       exit("Create file error!"); 
} 
$handle2 = fopen($_FILES['trackdata']['tmp_name'],"r"); 
$data = fread($handle2,$_FILES['trackdata']['size']); 
echo $data; 
fwrite($handle,$data); 
fclose($handle2); 
fclose($handle); 
exit(0); 
?>  
 
ASP:  (review the full code in the install folder\samples\asp\) 
<%@Language=VBScript %> 
<!-- #include file="./include/upload.inc" --> 



<!--#include file="./include/conn.asp"--> 
<% 
Set Uploader = New UpFile_Class 
Uploader.NoAllowExt="cs;vb;js;exe"  
Uploader.GetData (Request.TotalBytes) 
Request.TotalBytes 
if Uploader.isErr then 
  select case Uploader.isErr 
        case 1 
        Response.Write "Fail to receipt the data." 
        case 2 
        Response.Write "The file is too big to upload" 
        End select 
        'Response.End 
End if 
Dim id  
If "" <> Request.QueryString("id") then  
        id = Request.QueryString("id") 
End if 
if id<>0 then  
    Sql="SELECT * from doc where doc.id = "&id 
else 
    Sql="SELECT * from doc" 
End if 
rs.Open Sql,conn,1, 3 
for each formName in Uploader.file 
        set file=Uploader.file(formName) 
        If id<>0 then  
                If("" = Request.QueryString("isAip")) Then  
                        rs("DocContent") = Uploader.FileData(formname 
                        rs("DocID") = Uploader.Form("DocID") 
                        rs("DocTitle") = Uploader.Form("DocTitle") 
                        rs("DocType") = Uploader.Form("DocType") 
                Else rs("AipContent")  = Uploader.FileData(formname)       
                        rs("state") = 2  
                End if 
        Else  
                rs.AddNew 
                rs("DocID") = Uploader.Form("DocID") 
                rs("DocTitle") = Uploader.Form("DocTitle") 
                rs("DocContent") = Uploader.FileData(formname)      
                rs("Docdate") = Now()  
                rs("DocType") = Uploader.Form("DocType") 
                rs("state") = 1 
        End If 
set file=nothing 
rs.Update 
exit for  
next 
rs.Close 
Set rs=Nothing 
conn.close 
set conn = Nothing 
Set Uploader = Nothing 
%>  
 
JSP:  
jsp: 
<%@ page contentType="text/html; charset=UTF-8" %> 



<%@ page language="java" import="com.jspsmart.upload.File> 
<jsp:useBean id="mySmartUpload" scope="page" class="com.jspsmart.upload.SmartUpload" 
/> 
<% 
String sPath="C:\\" 
mySmartUpload.initialize(pageContext); 
mySmartUpload.upload(); 
String TempName=mySmartUpload.getRequest().getParameter("TempName"); 
mySmartUpload.save(sPath); 
File myFile =mySmartUpload.getFiles().getFile(0); 
%> 
 

boolean HttpOpenFileFromStream(BSTR WebUrl, BSTR 
ProgID,  [in, optional] VARIANT WebUsername, [in, optional] 
VARIANT WebPassword); 

Opens a file from a stream with the HTTP/HTTPS. 
WebUrl: A string containing the web url from which downloads data via HTTP. The WebUrl 
must include the file extend name so that the component know the file type. For example: 
http://www.edrawsoft.com/Getfile.aspx?ID=1002&FileName=guid.xls, or 
http://www.edrawsoft.com/sample.xlsx. 
ProgID: Word.Application, Excel.Application or PowerPoint.Application. 
WebUsername: A string containing the user name. 
WebPassword: A string containing the access password. 
 
Example: 
Either you want to open an appointed file or open a file from database, for client side, all what 
you need do is the same, like following: 
<script language="vbscript"> 
Sub DownloadFile() 
       EDOffice.HttpInit(); 
       EDOffice.HttpAddpostString("DocumentID", "Tester.xls"); 
       EDOffice.HttpOpenFileFromStream(strDownloadPath, ”Excel.Application”); 
End Sub 
</script>  
 
Before you call function HttpOpenFileFromStream, you should do two things, one is to initialize 
http for clearing all parameters and cookies in http, another thing is to appoint the file or 
database record. And then use HttpOpenFileFromStream to send the request to the destinated 
webpage. Before HttpOpenFileFromStream send request, it will add a couple of parameters 
automatically. 
EDOffice.AddPostArgument(L"EDA_GETSTREAMDATA", L"EDA_YES"); This couple of 
parameters tell the destinated webpage EDOffice will received file as stream. 
 
At the web side, webpage will decide to read which file or database reacord accordding to the 
post parameters. And you should add boundary flag 'EDA_STREAMBOUNDARY' to file data, 
following is the asp.net demo. 
 
if (Request.Params["EDA_GETSTREAMDATA"] == "EDA_YES") 
{ 
  String fullFileName = Server.MapPath(Request.Params["DocumentID"]); 
  Byte[] fs = File.ReadAllBytes(fullFileName); 
 
  Response.Write("Get Stream Successfully!"); 



  Response.Write("EDA_STREAMBOUNDARY"); 
  Response.BinaryWrite(fs); 
  Response.Write("EDA_STREAMBOUNDARY"); 
}  
 
asp: 
 
If l_bWrSreamBoundary  
Then Response.Write "EDA_STREAMBOUNDARY" 
While Not l_stream.EOS And Response.IsClientConnected  
Response.BinaryWrite(l_stream.Read(l_nChunkSize))  
Wend l_stream.Close  
If l_bWrSreamBoundary  
Then Response.Write EDA_STREAMBOUNDARY" 
 

BSTR HttpDownloadFileToTempDir(BSTR WebUrl, [in, 
optional] VARIANT WebUsername, [in, optional] VARIANT 
WebPassword); 

Downloads a file from a remote server then save it to OA temporary 

directory with HTTP. 
WebUrl: A string containing the web url from which downloads data via HTTP. The WebUrl 
must include the file extend name so that the component know the file type. For example: 
http://www.edrawsoft.com/Getfile.aspx?ID=1002&FileName=guid.edxz, or 
http://www.edrawsoft.com/sample.edxz. 
WebUsername: A string containing the user name. 
WebPassword: A string containing the access password. 
Return Value: Local temporary file path to save the download file. 
 
The component provides the method to download file from a server then save to a local disk 
file. Support Http and HTTPS. 
 
<script language="vbscript"> 
Sub DownloadFile() 
       Dim sPath; 
       sPath = EDOffice.HttpDownloadFileToTempDir “http://www.edrawsoft.com/demo/1.doc” 
       EDOffice.Open sPath 
End Sub 
</script>  
 
Note: You should make sure you the file exists in the web site firstly. A simple method is to 
enter the WebUrl in the Internet Explore. If IE can download the file, the component can do it 
too.  
 
FAQ: If you are using Windows 2003 as your server, you maybe need to add the mime types 
to Internet Information Server. 
 

boolean FtpConnect(BSTR WebUrl, [in, optional] VARIANT 
WebUsername, [in, optional] VARIANT WebPassword); 



Creates a FTP connect. 

 

boolean FtpDownloadFile(BSTR RemoteFile, BSTR LocalFile); 

Downloads a file from remote server then save it to local file with FTP. 
RemoteFile: The remote file path which saves to FTP site. 
LocalFile: The full file path which downloads to the local disk. 
 

boolean FtpUploadFile(BSTR LocalFile, BSTR RemoteFile, 
boolean OverWrite); 

Uploads a local disk file to remote server with FTP. 
LocalFilePath: The full file path needs to upload to the server. It the parameter is NULL, the 
function will add the file which is opening in the component. 
RemoteFile: The remote file path which saves to FTP site. 
OverWrite: Overwrites the exsited file if the same file exists at the FTP server. 
 

boolean FtpDisConnect(); 

Closes the FTP Connect. 
The follow code is demo how to download a file to local disk with the FTP mode. 
 
<script language="vbscript"> 
Sub UploadFileviaFTP() 
EDOffice.FtpConnect “ftp.edrawsoft.com”, “username”, “password”  
EDOffice.FtpDownloadFile “ftp.edrawsoft.com/archieve/001.doc”, “c:\temp.doc” 
EDOffice.FtpDisConnect  
End Sub 
</script> 
 

long GetErrorCode(); 

Returns the error code. 

 

BSTR GetTempFilePath([in, optional] VARIANT RefFileName); 

Gets a temporary file path. 



RefFileName: The referent file name. 

 

boolean ClearTempFiles(); 

Clears these temporary files created by the component. The function 

won't delete any other files out of temporary ED directory. 

 

boolean SetComponentSize(long Width, long Height); 

Sets the width and hieght of the component. 

 

boolean SlideShowPlay([in] VARIANT_BOOL 
bShowWebToolbar, [in] VARIANT_BOOL bLoopUntilStopped, 
[in] VARIANT_BOOL bShowScrollBar); 

Plays the slide show file. 

 

void ShowRibbonTitlebar([in] VARIANT_BOOL Show); 

Shows/Hides the title bar in the office ribbon interface. 
 
For Office 2007 and Office 2010, you can hide the Ribbon title bar with 
the method in the BeforeDocumentOpened event. 
 

void ShowMenubar([in] VARIANT_BOOL Show); 

Shows/Hides the menu bar in the office interface.  
 

For Office 2000, Xp, 2003, you can hide the menu bar with the method 
in the BeforeDocumentOpened event. For office 2007 and higher 
version, you can use the DisableFileCommand method. 
 

boolean SetComponentSize([in] long Width, [in] long Height); 



Resizes the width and height of component. 
 

 

void DisableStandardCommand([in] CommandType CmdType, 
[in] BOOL Disable); 

Disables the standard file, save, print commands.  
 
You can disable the standard commands in the office. Then write your 
own process in the event. 
 
enum CommandType{ 

cmdTypeSave = 0x00000001, 

cmdTypeClose = 0x00000002, 

 cmdTypePrint = 0x00000004,   

 cmdTypeRightClick = 0x00000008, 

 cmdTypeDoubleClick = 0x00000010, 

 cmdTypeIESecurityReminder = 0x00000020, 

}CommandType; 
 
The follow code is demo how to disable the print process. 
 
function OA_DocumentBeforePrint() 
{ 
document.OA1.DisableStandardCommand(4, true);//cmdTypePrint = 0x00000004,   
} 
<script language="javascript" for="OA1" event="DocumentBeforePrint()">  
  OA_DocumentBeforePrint(); 
</script> 
 
 
 

 

 
 



Event 
 

[id(1), helpstring("Occurs after the control has completed the 
initialization.")] 

void NotifyCtrlReady(); 

 
Example 
The following script to hide the toolbar and grid when the component was initialized. 
 
function EDOffice_NotifyCtrlReady()  
{ 
 document.all.EDOffice.LicenseName = ""; 
 document.all. EDOffice.LicenseCode = ""; 
 document.all.EDOffice.BorderStyle = 1; 
 document.all.EDOffice.Toolbars = false; 
} 
<SCRIPT LANGUAGE=javascript FOR=EDOffice EVENT=NotifyCtrlReady> 
<!-- 
  EDOffice_NotifyCtrlReady(); 
//--> 
</SCRIPT> 
 
  

[id(2), helpstring("Called when the new document is 
created.")] 

void NewDocument(); 

 

[id(3), helpstring("Called before document is opened or new 
document added.")] 

void BeforeDocumentOpened(); 

 
Example 
The following script to add office UI setting before a document opened. 
  
function EDOffice_BeforeDocumentOpened()  
{ 
 EDOffice.DisableFileCommand 1 , false    ‘wdUIDisalbeOfficeButton    

EDOffice.DisableFileCommand 2 , false    ‘wdUIDisalbeNew 
EDOffice.DisableFileCommand 4 , false   ‘wdUIDisalbeOpen 
EDOffice.DisableFileCommand 16 , true    ‘wdUIDisalbeSave 



EDOffice.DisableFileCommand 32 , true    ‘wdUIDisalbeSaveAs 
} 
<SCRIPT LANGUAGE=javascript FOR=EDOffice EVENT= BeforeDocumentOpened > 
<!-- 
  EDOffice_ BeforeDocumentOpened (); 
//--> 
</SCRIPT> 
 
 

[id(4), helpstring("Called when document is opened or new 
document added.")] 

void DocumentOpened(); 

Example 
The following script to add office automation after a document was opened. 
  
function EDOffice_DocumentOpened()  
{ 
 var objExcel = document.OA1.GetApplication();  
 var worksheet = objExcel.ActiveSheet; 
 worksheet.cells(1,1).value ="100"; 
 worksheet.cells(1,2).value ="101"; 
 worksheet.cells(1,3).value ="102"; 
 worksheet.cells(2,1).value ="103"; 
 worksheet.cells(2,2).value ="104"; 
 worksheet.cells(2,3).value ="105"; 
} 
<SCRIPT LANGUAGE=javascript FOR=EDOffice EVENT= DocumentOpened > 
<!-- 
  EDOffice_ DocumentOpened (); 
//--> 
</SCRIPT> 
 
 
 

[id(5), helpstring("Called before document is closed (may be 
canceled).")] 

void BeforeDocumentClosed(); 

 

[id(6), helpstring("Called before document is saved (may be 
canceled).")] 

void BeforeDocumentSaved(); 

 



[id(7), helpstring("Called before right click the component.")] 

void WindowBeforeRightClick(); 

You can add your own right click menu here. 
 
 

[id(8), helpstring("Called before double click the 
component.")] 

void WindowBeforeDoubleClick();  

 

[id(9), helpstring("Called before double click the 
component.")] 

void WindowSelectionChange(); 

 

[id(10), helpstring("Called before double click the 
component.")] 

void DocumentBeforePrint(); 

 

[id(11), helpstring("Called when the file was downloaded 
completely.")] 

void WindowActivate(); 

[id(12), helpstring("Called when the file was downloaded 
completely.")] 

void WindowDeactivate(); 

 

[id(13), helpstring("Called before downloading the file.")] 

void BeforeDownloadFile(); 



 

[id(14), helpstring("Called when the file was downloaded 
completely.")] 

void DownloadFileComplete(); 

 

[id(15), helpstring("Called when the file was uploaded 
completely.")] 

void UploadComplete(); 

 

[id(16), helpstring("Called when the IE is in the protection 
mode.")] 

void IESecurityReminder([in,out] VARIANT* Cancel); 

 
Example 
The following script to reminder the user added your site in trusted site list. 
  
function EDOffice_IESecurityReminder()  
{ 
EDOffice.SetValue “Domain”, “www.edrawsoft.com” 
‘or you can customize the whole sentense by set the ProtectModeReminder value. 
‘EDOffice.SetValue “ProtectModeReminder”, “The ActiveX Controls is not available for Internet 
sites under the protection mode. You can add www.yoursite.com to trusted site list.” 
} 
<SCRIPT LANGUAGE=javascript FOR=EDOffice EVENT= IESecurityReminder> 
<!-- 
  EDOffice_ IESecurityReminder (); 
//--> 
</SCRIPT> 
 



Property 
[id(1)] boolean ShowToolbars; 
Shows or hides the toolbars. 
 
[id(2)] BSTR LicenseName; 
Sets the license name. 
 
[id(3)] BSTR LicenseCode; 
Sets the license code. 
 
[id(4)] OLE_COLOR BorderColor; 
Sets the border color the control. 
 
[id(5)] long BorderStyle; 
Sets the border style of the control. 
 
 



 

Constants 
typedef enum BorderStyle 
{ 
BorderNone = 0, 
BorderFlat, 
Border3D, 
Border3DThin 
} BorderStyle; 
 
typedef enum FileCommandType 
{ 
FileNew = 0, 
FileOpen, 
FileClose, 
FileSave, 
FileSaveAs, 
FilePrint, 
FilePageSetup, 
FileProperties, 
FilePrintPreview 
} FileCommandType; 
 
typedef enum XlFileFormat 
{ 
xlAddIn = 18, 
xlCSV = 6, 
xlCSVMac = 22, 
xlCSVMSDOS = 24, 
xlCSVWindows = 23, 
xlDBF2 = 7, 
xlDBF3 = 8, 
xlDBF4 = 11, 
xlDIF = 9, 
xlExcel2 = 16, 
xlExcel2FarEast = 27, 
xlExcel3 = 29, 
xlExcel4 = 33, 
xlExcel5 = 39, 
xlExcel7 = 39, 
xlExcel9795 = 43, 
xlExcel4Workbook = 35, 
xlIntlAddIn = 26, 
xlIntlMacro = 25, 
xlWorkbookNormal = -4143, 
xlSYLK = 2, 
xlTemplate = 17, 
xlCurrentPlatformText = -4158, 
xlTextMac = 19, 
xlTextMSDOS = 21, 
xlTextPrinter = 36, 
xlTextWindows = 20, 
xlWJ2WD1 = 14, 
xlWK1 = 5, 



xlWK1ALL = 31, 
xlWK1FMT = 30, 
xlWK3 = 15, 
xlWK4 = 38, 
xlWK3FM3 = 32, 
xlWKS = 4, 
xlWorks2FarEast = 28, 
xlWQ1 = 34, 
xlWJ3 = 40, 
xlWJ3FJ3 = 41, 
xlUnicodeText = 42, 
xlHtml = 44 
}XlFileFormat; 
 
typedef enum WdSaveFormat 
{ 
wdFormatDocument = 0, 
wdFormatTemplate = 1, 
wdFormatText = 2, 
wdFormatTextLineBreaks = 3, 
wdFormatDOSText = 4, 
wdFormatDOSTextLineBreaks = 5, 
wdFormatRTF = 6, 
wdFormatUnicodeText = 7, 
wdFormatEncodedText = 7, 
wdFormatHTML = 8, 
wdFormatWebArchive = 9, 
wdFormatFilteredHTML = 10, 
wdFormatXML = 11 
}WdSaveFormat; 
 
typedef enum PpSaveAsFileType 
{ 
ppSaveAsPresentation = 1, 
ppSaveAsPowerPoint7 = 2, 
ppSaveAsPowerPoint4 = 3, 
ppSaveAsPowerPoint3 = 4, 
ppSaveAsTemplate = 5, 
ppSaveAsRTF = 6, 
ppSaveAsShow = 7, 
ppSaveAsAddIn = 8, 
ppSaveAsPowerPoint4FarEast = 10, 
ppSaveAsDefault = 11, 
ppSaveAsHTML = 12, 
ppSaveAsHTMLv3 = 13, 
ppSaveAsHTMLDual = 14, 
ppSaveAsMetaFile = 15, 
ppSaveAsGIF = 16, 
ppSaveAsJPG = 17, 
ppSaveAsPNG = 18, 
ppSaveAsBMP = 19, 
ppSaveAsOpenXMLPresentation = 24, 
ppSaveAsOpenXMLPresentationMacroEnabled = 25, 
ppSaveAsOpenXMLShow = 28, 
ppSaveAsOpenXMLShowMacroEnabled = 29, 
ppSaveAsOpenXMLTemplate = 26, 
ppSaveAsOpenXMLTemplateMacroEnabled = 27,  
}PpSaveAsFileType; 
 



typedef enum WdPrintOutRange 
{ 
wdPrintAllDocument = 0, 
wdPrintSelection = 1, 
wdPrintCurrentPage = 2, 
wdPrintFromTo = 3, 
wdPrintRangeOfPages = 4 
}WdPrintOutRange; 
 
typedef enum WdProtectType 
{ 
wdAllowOnlyRevisions = 0, 
wdAllowOnlyComments = 1, 
wdAllowOnlyFormFields = 2, 
wdAllowOnlyReading = 3, 
wdNoProtection = -1, 
}WdProtectType; 
 
typedef enum XlProtectType 
{ 
XlProtectTypeNormal = 0x00000001, 
XlProtectTypeWindow = 0x00000002, 
XlProtectTypeStruct = 0x00000004, 
XlProtectTypeDrawingObjects = 0x00000010, 
XlProtectTypeContents = 0x00000020, 
XlProtectTypeScenarios = 0x00000040, 
XlProtectTypeUserInterfaceOnly = 0x00000080, 
}XlProtectType; 
 
typedef enum PpViewType 
{ 
ppViewHandoutMaster = 4, 
ppViewMasterThumbnails = 12, 
ppViewNormal = 9, 
ppViewNotesMaster = 5,  
ppViewNotesPage = 3, 
ppViewOutline = 6, 
ppViewPrintPreview = 10,  
ppViewSlide = 1, 
ppViewSlideMaster = 2,  
ppViewSlideSorter = 7, 
ppViewThumbnails = 11, 
ppViewTitleMaster =8, 
}PpViewType; 
 
typedef enum WdViewType 
{ 
wdMasterView = 5,  
wdNormalView = 1 , 
wdOutlineView = 2, 
wdPrintPreview = 4 , 
wdPrintView = 3,  
wdReadingView = 7,  
wdWebView = 6, 
}WdViewType; 
 
typedef enum XlViewType 
{ 
xlNormalView = 1 , 



xlPageBreakPreview = 2, 
}XlViewType; 
 
typedef enum WdPageFit 
{ 
wdPageFitTextNone = 0 , 
wdPageFitFullPage = 1, 
wdPageFitBestFit = 2, 
wdPageFitTextFit = 3 , 
}WdPageFit; 
 
typedef enum CommandType{ 
cmdTypeSave = 0x00000001, 
cmdTypeClose = 0x00000002, 
cmdTypePrint = 0x00000004,   
cmdTypeRightClick = 0x00000008, 
cmdTypeDoubleClick = 0x00000010, 
cmdTypeIESecurityReminder = 0x00000020, 
}CommandType; 
 
typedef enum WdUIType 
{ 
wdUIDisalbeOfficeButton   =    0x00000001, 
wdUIDisalbeNew=    0x00000002, 
wdUIDisalbeOpen =    0x00000004, 
wdUIDisalbeUpgradeDocument     =    0x00000008, 
wdUIDisalbeSave=    0x00000010, 
wdUIDisalbeSaveAs=    0x00000020, 
wdUIDisalbeSendAsAttachment   =    0x00000040, 
wdUIDisalbeClose =    0x00000100, 
wdUIDisalbePrint =    0x00000200, 
wdUIDisalbePrintQuick   =    0x00000400, 
wdUIDisalbePrintPreview   =    0x00000800, 
wdUIDisalbeSaveAsMenu   =    0x00001000, 
wdUIDisalbePrepareMenu   =    0x00002000, 
wdUIDisalbePermissionRestrictMenu   =    0x00004000, 
wdUIDisalbeSendMenu =    0x00008000, 
wdUIDisalbePublishMenu =    0x00010000, 
wdUIDisalbeServerTasksMenu   =    0x00020000, 
wdUIDisalbeCopyButton   =    0x00040000, 
wdUIDisalbeCutButton   =    0x00080000, 
wdUIHideMenuHome   =    0x01000000, 
wdUIHideMenuInsert   =    0x02000000, 
wdUIHideMenuPageLayout   =    0x04000000, 
wdUIHideMenuReferences   =    0x08000000, 
wdUIHideMenuMailings   =    0x10000000, 
wdUIHideMenuReview   =    0x20000000, 
wdUIHideMenuView   =    0x40000000, 
wdUIHideMenuDeveloper   =    0x80000000, 
wdUIHideMenuAddIns   =    0x00100000, 
}WdUIType; 
 
typedef enum OAErrorCode{ 
eSC_Ok = 0, 
eSC_GenericError, 
eSC_InvalidFileType, 
eSC_InvalidSite, 
eSC_WrongDNS,  
eSC_CreateTempFileFailed, 



eSC_OpenUploadFileFailed, 
eSC_SaveOpenedFileFailed, 
eSC_NotHttpURL, 
eSC_ConnectFailed, 
eSC_RequestFailed, 
eSC_RequestHeaderFailed, 
eSC_EmptyArgument, 
eSC_OpenFileArgumentFailed, 
eSC_SendRequestFailed, 
eSC_WriteDataFailed, 
eSC_ReadDataFailed, 
eSC_EndRequestFailed, 
eSC_OpenFileFailed, 
eSC_InvalidReturnData, 
}OAErrorCode; 



 

System Requirements 
Hardware :  
 
Minimum:  
 
Pentium Based MMX processor 500 MHZ  
256 MB of ram  
SVGA Graphics card  
64 MB HardDisk  
Recommended:  
 
Intel Celeron or AMD Duron 1 GHz and above  
1 GB ram  
SVGA Graphics card with some acceleration (1024x768x16bitsColor)  
 
Software :  
 
Minimum:  
 
Windows 2000  with IE6 and above.  
 
Recommended:  
IE 6/7/8  
Windows 2000/XP/2003/Vista/Windows 7  
Office 2000/XP/2003/2007/2010 
 
For web application:  The component need IE Protection Mode was Turn Off.  
 
You can added your site at the IE trusted site list to turn off the IE protection mode 
automatically when the users visit your site with the component.  
 
 
  
Please consider also your application's requirements. 
 



 

Redistribute Files 
 
Here are the files needed for installing Edraw Office Viewer Component. 
 
DLL and OCX 
 
officeviewer.ocx 
EDOfficeViewerX.dll 
 
Or you can use the cab file in the install folder for web application. 
 
officeviewer.cab  
 
 



 

Visual Basic Issue 
How to add Office ActiveX Control to your Visual Basic 6.0 project  
 

1. From the Project Menu select Components… 
2. Select control “Edraw Office Viewer Component Module” in the controls table. 
3. Click the OK Button. 
4. The control will now appear in your toolbox. 
5. Drag and drop the control on your form. 
6. Right click the control then choose the View Code… item. 
7. Add the NotifyCtrlReady event and set the library file to load. 

Private Sub EDOffice_NotifyCtrlReady() 
EDOffice.LicenseName = "" 
EDOffice.LicenseCode = "" 
End Sub  

8. Run the project. 



 

Visual C++ Issues 
Adding the control to a simple dialog base Application 

 
1. Begin a new MFC AppWizard(exe) dialog base Application.  
2. Open The Resources Dialogs. 
3. Select the Main Dialog and right click on it.  
4. From pop-up menu select “Insert ActiveX Control…”. 
5. Select Edraw Office Viewer Component from the list. 
6. Add a member variable to newly created control in the dialog class. 
7. This will automatically generate new cpp and .h files which including the information of 

EDOffice control. 
8. Call the MFC ClassWizard to add the control event message 

 
To resize the control according the form add a new Window Message Handler WM_SIZE and 
add the following code in OnSize virtual function 
 
    if(!::IsWindow(m_EDOffice.m_hWnd)) return; 
 
    m_EDOffice.MoveWindow(0,0,cx,cy); 
 
  See VCEDOfficeDemo c++ example 
 
  
 
Upgrade a control in VC++ 
You can easily upgrade a VC++ project witch is using a EDOffice control of a previous version: 
 

1. Register the new version of control using the regsvr32 utility that is located in 
windows system directory.  

2. From Project menu select Add to Project -> Components and Controls  
3. From Components and Control Gallery dialog select the folder Registered ActiveX 

Controls  
4. Find and select Edraw Office Viewer Component and click OK to all next dialogs.  
5. Rebuild the project. 

   



 

Web Application Issue 

Use the officeviewer.cab file 

The component can be used for web application. You can embed it at the 
html Object tag. 
 
<object classid="clsid: 7677E74E-5831-4C9E-A2DD-9B1EF9DF2DB4" 
id="EDOffice" width="100%" height="100%" 
codebase="http://www.yoursite.com/download/officeviewer.cab#7,0,0,141"
> 
</object> 
 
Note: You should put the officeviewer.cab file in your own site and change 
the codebase url when you distribute the component.  
 
You can view the html samples in the install folder\samples\html folder. 
 
The EDOffice.cab file is available in the intall folder. You can create your own 
cab file. 

Why do I fail to download the ActiveX control on the client 

machine 

The failure of loading ActiveX control has the following possible causes: 
 
1. The security settings of IE on the client machine are incorrect. 
 
Please verify the following security settings of IE to "Prompt" or "Enabled": 
a) Download signed ActiveX controls 
b) Run ActiveX Controls and plug-ins 
c) Script ActiveX controls marked safe for scripting 
 
The dialog box of the security setting can be launched from menu 
Tools>Internet Options. Then select the security tab.  

How to add Edraw Component to your ASP.NET project  

1. Open Visual Studio. 
2. Create a new ASP.NET project. 
3. Don not attempt to add the Edraw Office Viewer Component to the 
Toolbox. It is a client component. You can add it as the HTML Object. 



4. Copy all files at the ASP_c#\ to the new project folder. 
( UploadAction.aspx UploadAction.aspx.cs Default.aspx.cs Default.aspx 
Tester.doc ) 
5. Then add exist items... 
6. Modify the Server Port in the Default.aspx. 
6. Run.  
 
About the IE Protection Mode 
 
The component can’t run at the IE protection mode. So the client needs add 
the site in IE trusted site list. The component will pop up the reminder dialog 
if it run at the IE protection mode.



 

Convert to Full Version 
 
The trial version has 60 day limiation. 
 
After you put the order, you will get the full version download link and the license key. 
 
Step: 
 

1. Firstly you need uninstall the trial version from your computer. Make sure the 
officeviewer.ocx file has been removed from your computer completed. 

2. Install the full version. In the install folder, you can find all files to redistribute. 
3. For VC, VB, C# destop application, you can set LicenseName and LicenseCode 

property directly in the Property panel. 
4. For Web Application, you need set the two properies in the NotifyCtrlReady event. 

<script language="javascript"> 
function EDOffice_NotifyCtrlReady()  
{ 
document.EDOffice.LicenseName = "your license name"; 
document.EDOffice.LicenseCode = "your license code"; 
} 
</script> 
<SCRIPT LANGUAGE=javascript FOR=EDOffice EVENT=NotifyCtrlReady> 
<!-- 
 EDOffice_NotifyCtrlReady(); 
//--> 
</SCRIPT> 
<object classid="clsid: 7677E74E-5831-4C9E-A2DD-9B1EF9DF2DB4" id="EDOffice" 
width="100%" height="100%" 
codebase="http://www.yoursite.com/download/officeviewer.cab#7,0,0,141"> 
</object> 

5. At last you can call the EDOffice.AboutBox method to verify the license. The trial 
version will show “30 day trial license for evaluation”. But the full license version will 
show your license name. 

 
 
 
Online Store: http://www.edrawsoft.com/officeviewer.php 
 
License Agreement: http://www.edrawsoft.com/download/edcomponentlicenseagreement.pdf 
 
Support Email: support@ocxt.com 
 
 
 
 


